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C H A P T E R  1

              
Introducing NetObjects Fusion1

NetObjects Fusion™ 2.0 is the first smart Web site production application that 

combines automated site building, professional quality design, and data publishing 

features. Its visual, site-oriented approach to Web site authoring offers 

unprecedented efficiency and ease of use for users of all levels. 

This chapter will help you

● understand NetObjects Fusion and its new features 

● verify that your computer has all the hardware and software   
NetObjects Fusion requires

● install NetObjects Fusion

● use the NetObjects Fusion manuals

● get help if you need it
Introducing NetObjects Fusion 1-1
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Overview of NetObjects Fusion
The following sections briefly describe NetObjects Fusion, the differences between 

NetObjects Fusion and conventional tools, and who will use NetObjects Fusion.

What Is NetObjects Fusion?
NetObjects Fusion is a fully integrated, site-oriented, visual Web site builder. 

NetObjects Fusion helps site designers:

● conceive and plan the site structure

● build and manage site pages

● design and author page content

● design the graphic style of the site 

● collect, manage, and test site assets

● publish the site to local or remote servers

● update and maintain the site

With NetObjects Fusion, you can work with your Web site as a whole. You can edit 

every aspect—from the site structure down to individual page components—

without HTML coding. It gives you centralized control over external files such as 

images, applets, and sounds, as well as elements that appear on many pages, such as 

page borders, styles, banners, navigation bars, and links. When you edit an element, 

NetObjects Fusion automatically checks whether your change impacts the 

consistency of your site and updates any related elements if needed. For example, 

when you move a page from one part of your site to another, NetObjects Fusion 

updates all links and navigation bars to reflect your new structure. If you have a 

Windows system, you can easily connect your site to a database, then sit back as 

NetObjects Fusion automatically creates a Web page for each database record 

according to the page layout you design. When you are finished designing your 

pages, NetObjects Fusion generates your site as a series of HTML files and publishes 

it on any Web server.
1-2 Introducing NetObjects Fusion
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The NetObjects Fusion Difference
Most Web site production tools are page-oriented. Typically they combine a text-

based page editor with some file management capabilities that help you create 

linked HTML pages in individual files. With this approach, you must create your 

entire Web site in a “bottoms-up” fashion— manually creating each page and 

linking them to others to build the site. To update the site, you must manually 

change graphics, elements, links, and references in each Web page file.

If you’ve used one of these tools in a real-world scenario that includes dozens or 

hundreds of constantly changing, interlinked pages, you know how page-oriented 

tools can create site management nightmares. The more you add to and reorganize 

your site, the more difficult it becomes to ensure that all the components of your site 

are consistent, accurately updated, and functional.

NetObjects Fusion is the first product to provide a site-oriented approach to Web 

site design and production. you can create a site structure, lay out your pages, and 

manage site assets and links within one NetObjects Fusion file. NetObjects Fusion’s 

top-down approach lets you start with a Home page and build a logical structure 

below. When you change an element, all pages that share the element are 

automatically updated. These features and more overcome the key limitations of the 
Introducing NetObjects Fusion 1-3
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current generation of page-based tools. To learn more about the NetObjects Fusion 

approach, refer to Chapter 2, “Exploring NetObjects Fusion.”

Figure 1-1. Site Construction Approaches

Who Uses NetObjects Fusion?
NetObjects Fusion is fast becoming the tool of choice for site designers with a broad 

range of experience levels. It can benefit almost anyone who needs an efficient, 

reliable way to construct and maintain professional-quality Internet and intranet 

sites. Experienced site builders appreciate how NetObjects Fusion reduces the time 

and effort required to create and manage large sites. Graphic designers value how it 

extends their control over sites—they don’t have to hand off their designs to HTML 

experts. Site directors and sponsors are pleased by how quick prototypes and instant 

visualization of the site structure keeps them close to the development process. 

People who are new to Web site production value the ability to create a compelling 

site without learning HTML and other technical skills. And all appreciate 

NetObjects Fusion’s open architecture, which lets their sites quickly take advantage 

of the latest developments in Web publishing technology.

Site-Oriented Approach Page-Oriented Approach
1-4 Introducing NetObjects Fusion
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What’s New in NetObjects Fusion
NetObjects Fusion 2.0 provides over 100 new features and improvements. The most 

significant innovations are summarized below. For a complete list, see “New 

Features in Version 2.0” on page 4-6.

Import Sites and Pages

To help you leverage your existing Web development investment, NetObjects 

Fusion’s new Site Import feature brings entire Web sites into NetObjects Fusion. 

When you provide the URL to your Home page, NetObjects Fusion finds your site 

on the Web, analyzes all its pages and assets, detects and captures the site’s 

hierarchical structure, and at your option converts each page to NetObjects Fusion 

format. Converted pages are nearly identical to your original HTML pages. Once 

you’ve imported a site, you can take advantage of NetObjects Fusion’s tools to easily 

enhance, upgrade, and maintain the site.

MasterBorders

To give you centralized control over elements that appear on many pages, 

NetObjects Fusion’s revolutionary new MasterBorders™ let you place master 

(repeating) elements in any page margin: top, bottom, left, or right. You can use 

MasterBorders to present navigation elements, banners, text, and artwork that you 

want to appear throughout a section or site. NetObjects Fusion 2.0 is the first site 

authoring tool to offer this level of design flexibility for page borders.

AutoFrames

A frame lets a site visitor scroll the body of a Web page while the items in the frame, 

such as navigation buttons, remain in view for easy access.NetObjects Fusion’s new 

AutoFrames™ feature revolutionizes frame creation. At the click of a button, you 

can turn any MasterBorder into an HTML frame. Then it’s easy to give the frame a 

different color or picture background than the page body, as well as properties such 

as borderless, user-resizable or user-scrollable. 

NFX Components

 NetObjects Fusion’s new NFX Components let you add sophisticated, interactive 

functionality to your Web site through an easy drag-and-drop interface. By simply 
Introducing NetObjects Fusion 1-5
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placing a component on your page, you can add a complex application to your site 

such as a message board or site map. For a list of NFX Components included with 

NetObjects Fusion, see “New Features in Version 2.0” on page 4-6. In the future, 

third-party developers will offer NFX Components as well.

Installing NetObjects Fusion
To install and run NetObjects Fusion, your computer system must meet the 

requirements listed below.

Hardware Requirements

Windows

● PC-compatible computer with a 486/66 or better processor (Pentium® strongly 
recommended)

● SVGA or higher resolution graphics (800 x 600 with 256 colors or higher)

● Available hard disk space, depending on the kind of installation you intend to 
perform:

– 20 MB for a minimum installation

or

– 80 MB for a complete installation

● Available memory, depending on your operating system:

– 16 MB available RAM (24 MB recommended) with Windows 95

or

– 16 MB available RAM (32 MB recommended) with Windows NT

● Keyboard and mouse or other pointing device

● CD-ROM drive

Macintosh

● Power Macintosh™ or 100% compatible (Power Macintosh 8100 or greater 
recommended) 
1-6 Introducing NetObjects Fusion
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● Available hard disk space, depending on the kind of installation you intend to 
perform:

– 20 MB for a minimum installation

or

– 80 MB for a complete installation

● 16MB of total physical RAM (24 MB recommended) with 8 MB available 

● 256-color display 

●  TCP/IP compliance with Mac TCP or Open Transport 

● Keyboard and mouse or other pointing device

● CD-ROM drive

Software Requirements

Windows

● One of the following operating systems:

– Windows 95

– or

– Windows NT Workstation 3.51 or later

● Web browser software:

– Netscape Navigator™ 2.0 or later

– Microsoft® Internet Explorer 2.0 or later

or

– other HTML 3.X-compliant browsers

● TCP/IP stack such as Winsock 1.1 or later for remote FTP publishing

● 32-bit ODBC drivers for database publishing

Macintosh

● Macintosh Operating System 7.5 or greater 

● Web browser software:
Introducing NetObjects Fusion 1-7
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– Netscape Navigator™ 2.0 or later

– Microsoft® Internet Explorer 2.0 or later

or

– other HTML 3.X-compliant browsers

● TCP/IP stack for remote FTP publishing

Package Contents
In your complete NetObjects Fusion 2.0 package, you’ll find the following items:

● NetObjects Fusion 2.0 CD-ROM

● NetObjects Fusion 2.0 Getting Started

● NetObjects Fusion 2.0 User Guide

● License Agreement

● Registration Card

The CD-ROM contains the NetObjects Fusion installation program, electronic 

documentation, and related files.

Installing NetObjects Fusion
Installation takes only a few minutes, and the installer guides you with online 

instructions.

Note: For best performance, install NetObjects Fusion at the folder level location 
recommended by the installer.

If you are upgrading from a previous version of NetObjects Fusion, you do not have 

to remove it before installing 2.0. In fact, you might need your 1.0 version to prepare 

templates that will carry your work forward into the 2.0 environment. To install 

NetObjects Fusion 2.0, you’ll follow the same procedures as shown below for a new 

user. NetObjects Fusion 2.0 will be installed in its own folder that will not affect 

your 1.0 installation in any way. After you’ve installed version 2.0, see “Bringing 
1-8 Introducing NetObjects Fusion
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Your Sites and Assets Forward” on page 4-1 to learn how to update your old files for 

use in the new 2.0 environment.

To Install NetObjects Fusion on Windows

1. Insert the NetObjects Fusion 2.0 CD-ROM.

2. Open Windows Explorer, or the File Manager if you are using Windows 
NT.

3. Double-click the CD-ROM icon. 

4. Double-click setup.exe to begin the installation program. 

5. Click Next in the NetObjects Fusion install splash screen.

6. Read the License Agreement and click Yes to continue.

7. Read the Installation Warnings and click Next.

8. Select the install location and click Next to continue.

If you have a previous version of NetObjects Fusion installed, the 
installer displays the SiteStyles™ available in its folder.

9. Select the SiteStyles you would like to copy to the new installation folder 
and click Next.

10. Choose Typical, Compact, or Custom installation and then click Next to 
finish the install.

NetObjects Fusion is installed. You have the option of reading the 
Readme file at this time.

To install NetObjects Fusion on a Macintosh

1. Insert the NetObjects Fusion 2.0 CD-ROM.

2. Double-click the NetObjects Fusion 2.0 CD icon on your desktop.

3. Double-click the NetObjects Fusion 2.0 Installer icon.

4. Click Continue in the NetObjects Fusion 2.0 install splash screen.

5. Read the License Agreement and click Accept to continue.
Introducing NetObjects Fusion 1-9
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6. Use the drop-down menu in the upper left hand corner to install the full 
version (Easy Install) or selected components (Custom Install).

7. Select the install location. 

For best performance, accept the default which is currently set to the 
root of your hard disk.

8. Click Install.

9. Click Continue to close any open application, acknowledge the 
notification, and continue with the installation. 

When the installation is finished, a message appears indicating that the 
installation was successful. You now have the option to quit the Installer, 
continue installing more components, or restart your Macintosh.

10. If you chose Easy Install (in step 6), click Restart.

After your Macintosh has restarted, a NetObjects Fusion folder appears 
on your hard disk. Be sure to read the Read Me file before starting. It 
contains important, late-breaking news about NetObjects Fusion.

More About NetObjects Fusion
NetObjects™ provides three information sources that can help you learn to use 

NetObjects Fusion: product documentation, on-line help, and the support area on 

the NetObjects Web site.

Using the NetObjects Fusion Manuals
This manual assumes you are proficient on the platform on which you run 

NetObjects Fusion. If you are unfamiliar with Windows 95 and its interface 

conventions, see your Windows 95 User Guide. Likewise, consult the Windows NT 

User Guide if you need more information about Windows NT. If you need help with 

the Macintosh operating system, see your User Guide and the Apple Macintosh CD-

ROM that accompanies your system.

This manual also assumes that you are familiar with the Web and its terminology. If 

not, visit the NetObjects Web site for helpful information. 
1-10 Introducing NetObjects Fusion
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In this manual, all filenames, extensions, pathnames, and URLs appear in the 

Myriad typeface. Example names that you should replace with your own appear in 

italics. For simplicity, path names are shown only in the Windows format, which 

uses backslants, and are not repeated in the Macintosh format, which uses colons. 

This means if you’re a Macintosh user and you see NetObjects Fusion 2.0\User 

Sites\my site, you should interpret this as NetObjects Fusion 2.0:User Sites:my 

site and replace my site with the actual name of your site. 

This Getting Started guide can help readers of different experience levels.

● If you’re new to Web site production, read Chapter 2, “Exploring NetObjects 
Fusion,” for an overview of the issues, then follow the tutorial in Chapter 3 before 
beginning your own NetObjects Fusion projects. Remember, you do not need to 
know HTML to use NetObjects Fusion.

● If you’re familiar with Web site publishing, read Chapter 2 for a quick tour of 
NetObjects Fusion, then explore the tutorial in Chapter 3. The tutorial is the 
quickest way to learn basic NetObjects Fusion features. It also includes “Next 
Steps” sections that can guide your initial experiments with advanced features.

● If you’re upgrading from a previous version of NetObjects Fusion, read 
Chapter 4, “Upgrading from NetObjects Fusion 1.0 to 2.0,” which tells how to 
bring your sites and other assets forward into the 2.0 environment, and 
summarizes all the new features so you can identify and apply them quickly.

Once you’re familiar with NetObjects Fusion, you’ll refer to the NetObjects Fusion 

2.0 User Guide for detailed instructions on using each feature.

Getting Help
NetObjects Fusion for both Windows and Macintosh offer many on-line help 

options. 

Help for Windows Users

NetObjects Fusion provides a full Windows help system to assist you while creating 

your site. This help system includes:

● a Windows Help version of the NetObjects Fusion 2.0 User Guide
Introducing NetObjects Fusion 1-11
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Select Help Topics from the Help menu to launch the help system and display the 

main table of contents.

● context-sensitive help

– To view help for objects in the workspace and controls in dialogs and 

properties palettes, right-click the item, then select What’s This? from the pop-

up menu. 

Alternatively, to view help for dialog and palette controls, you can also click 

the question mark icon in the title bar, then click the item to display help.

– To view help for menu commands, highlight the command, then press the F1 

key.

NetObjects also provides help on its Web site, which you can access from within 

NetObjects Fusion by selecting Help Overview from the Help menu. This displays 

the NetObjects Help Overview HTML page appears in your browser. This page 

contains links to all the NetObjects Fusion support options, which include online 

documentation, active newsgroups, usage notes, and FAQs.

Help for Macintosh Users

NetObjects Fusion provides a full AppleGuide help system to assist you while 

creating your site. To begin, choose NetObjects Fusion Guide from the   menu. In 

the Guide window that appears, choose a method by which to search for what 

interests you.

● Click the Topic button to choose a topic from a list.

● Click the Index button to choose from a list of defined keywords.

● Click the Look For button to enter and search for any word that interests you.

Visiting the NetObjects Web Site
If you have questions on NetObjects Fusion that are not covered in this manual, the 

NetObjects Fusion 2.0 User Guide, or the on-line help system, visit the NetObjects 

Web site at:

         http://www.netobjects.com/
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Support options available on the site include the online Getting Started manual, 

PDF files of both the Getting Started and the NetObjects Fusion 2.0 User Guide, 

NetObjects Newsgroups, FAQs, and helpful usage notes. The NetObjects Fusion 2.0 

User Guide includes a chapter entitled “Using the NetObjects Web Site.” It lists URLs 

that take you directly to the most relevant areas of the site.
Introducing NetObjects Fusion 1-13



C H A P T E R  2
Exploring NetObjects Fusion 2

This chapter helps you get to know NetObjects Fusion by describing

● how it helps you meet site design challenges

● each of its main views and navigation within them

● the powers of its most strategic features

Solutions for Site Design
Web sites are growing in complexity and rich media content. As a site designer, you 

must update your site frequently to give site visitors the latest information and 

encourage them to return. And as your competitors’ sites become increasingly 

sophisticated, your site visitors develop higher expectations for your site’s 

appearance, interactivity, and functionality.

NetObjects Fusion is the first site design application that helps you keep pace with 

the rapidly evolving world of Web technology by providing:

● Site-oriented approach. NetObjects Fusion treats your site as a single entity, 
not as independent pages. You can use NetObjects Fusion to map the entire 
structure of your site, make global changes using centralized controls, and update 
your links automatically. This site-oriented approach provides for top-down and 
incremental site planning, consistent design, and intuitive end-user navigation. 

● Visual design interface. You have direct, visual control over your site structure 
and page design. With NetObjects Fusion, you can drag-and-drop pages from 
one branch of your site structure to another, and place elements on your pages 
using familiar layout tools. 

● Page layout. NetObjects Fusion features the first draw-based page layout editor 
that lets you design Web pages with pixel-level precision. Unlike text-based 
HTML tools, NetObjects Fusion gives you full drag-and-drop control over the 
position and layout of all page elements. Where you place elements on the page in 
NetObjects Fusion is exactly where you’ll see them in your browser.
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● Optimization for browser fonts. When viewed over the World Wide Web, the 
size and face of fonts on your page can vary depending on the site visitor’s 
browser, platform, and installed fonts. NetObjects Fusion 2.0 gives you 
unprecedented control over how these variations impact your design.

● Central graphic control. NetObjects Fusion’s SiteStyles automatically give the 
pages in your site a consistent look and feel. You can create, edit, and apply a 
SiteStyle to automate the use of graphic elements throughout your site.

● Automatic navigation and linking. Based on your site structure and SiteStyle, 
NetObjects Fusion automatically creates customizable navigation elements such 
as banners and navigation bars in all the pages of your site. As you rearrange and 
rename your pages, NetObjects Fusion automatically updates all associated links, 
including those for automatic navigation elements as well as any page links you 
have created. And testing links is a breeze. With a single command you can verify 
whether all links in your site—to pages in your site or to external sites—reference 
an existing destination.

● Database publishing. NetObjects Fusion makes it easy to publish database 
information. If you need to publish a catalog or indexed listing in your site, 
NetObjects Fusion can automatically generate a Web page for each record in your 
database, using a layout you design. Your data can include both text and pictures.

● Asset management. NetObjects Fusion gives you centralized control over files, 
links, and other critical information. For example, whenever you need to replace 
or modify a link or picture that appears on more than one page, you make the 
change once and NetObjects Fusion automatically updates each affected page.

● Open architecture. NetObjects Fusion supports the most advanced technology 
available for the Web today. For example, it lets you place an ActiveX control on 
your page with just a click of your mouse. As the HTML standard evolves, you 
can take advantage of the latest developments by adding your own tags and 
scripts. When the next innovation arrives, you’ll find you already have the tools 
you need to integrate it into your site.

● Templates. To give you a head start when creating new sites and pages, 
NetObjects Fusion offers AutoSites™ and Page templates, which are pre-designed 
for common needs such as a complete company intranet site or personal Home 
page. You simply replace the “for position only” content they contain with your 
own.
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● Site Import. Leverage your development investment in existing Web sites by 
importing them into NetObjects Fusion. Then you can take advantage of 
NetObjects Fusion’s centralized design controls, asset management, site structure 
editing and management, one-button updates, and more.

Touring NetObjects Fusion
NetObjects Fusion offers five different views that help you design, create, and 

manage your site. Changes you make in one view automatically appear in the 

others. You access the views via buttons on the control bar. 

Figure 2-1. View Control Buttons

The order in which the buttons appear guides you through the main steps of 

building a Web site. 

1. Start with the Site view to create the hierarchical structure of a new site 
or import an existing Web site. 

2. Use the Page view to create page layouts and add content to your pages. 

3. In the Style view, choose from among 50 pre-built SiteStyles to give your 
entire site a consistent look and feel, or create your own.

4. Use the Assets view to manage your site’s files, links, and other resources. 

5. When you are ready to stage or publish your completed site, use the 
Publish view. 

Your final product is a Web site that visitors can navigate in their browsers. You can’t 

depend on any two browsers to display your pages the same way. So NetObjects 

Fusion makes it easy for you to see how your design appears in the browser of your 

choice.
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At any time during the site production process, you can click the Preview button in 

the control bar to view your site in your browser. 

Figure 2-2. The Preview Button

Tip: To quickly preview just the page you are working on, hold down the Control key 

while clicking the Preview button.

The Site View
In Site view you can quickly create and arrange the hierarchy of your site’s sections 

and subsections by dragging and dropping page icons. 

Figure 2-3. The Site View
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Site view can present your site’s hierarchy either as a structure map, as shown above, 

or in an outline similar to the Windows Explorer or a Macintosh Finder window 

viewing files by name.

The structure you build establishes relationships among your pages. The pages in 

the row under the Home page are in the first level; the second row, the second level 

and so on. Pages below the Home page are called children. All other pages can have 

parent and sibling pages as well. NetObjects Fusion uses the structure you build to 

automatically create navigational elements such as banners, buttons, and links.

While in Site view, you can add to your site by importing sections. You can import 

AutoSites, page templates, or pages from sites on your disk or from the Web.

The Page View
The Page view is a drag-and-drop page layout editor that gives you pixel-accurate 

control of element positions. On each page, you can enter or create your own 

content, place content such as images or rich media, or import content from word 

processors or other Web pages. 

Figure 2-4. The Page View
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Your page is made up of two areas: MasterBorders and Layout. The MasterBorders 

area displays elements that repeat on a set of pages, much as headers and footers do 

in a word processing document. You can define different MasterBorders for 

different sets of pages. The Layout area displays content elements that are unique to 

this page. If you like, you can create multiple layouts per page; for example to 

support a foreign-language version of your site.

Page view offers two palettes. The Page Tools palette lets you add virtually any 

content to your pages. It differs slightly for Windows and Macintosh systems, as 

described in your NetObjects Fusion 2.0 User Guide. If you are unsure of which tool 

to use, position your pointer over a tool and after a few seconds, the name of the 

tool will appear.

Figure 2-5. The Page Tools Palette for Windows

The Properties palette displays the attributes of the area or element you have 

selected. You edit the displayed properties to control various aspects of the element 

or area. For example, when you select a drawn element, you can choose its line style 

on the Properties palette. Or when you select the MasterBorders area, you can 

convert it to an AutoFrame with a single click. 

Both palettes are displayed by default. For a better view of your work, you might 

want to close them until you need them—you can easily reopen them anytime from 

the View menu. Or on a Windows system, simply double-click the palette’s title bar 

to reduce it to just the title bar; double-click again to restore the palette. On a 

Select

Text

Picture

Table

NetObjects 
Components

Java Applet

Zoom in

Zoom out

Draw

Navigation Bar

Rich Media

ActiveX Control

Data List

Secondary tools
(Picture tool selected)

Data Field

Forms
2-6 Exploring NetObjects Fusion



T O U R I N G  N E T O B J E C T S  F U S I O N
Macintosh, you can hide the palettes using the method you choose in the 

WindowShade control panel.

The Style View
In Style view you examine, apply, create, and import SiteStyles. SiteStyles are sets of 

graphic elements for banners, buttons, lines and more. They help you establish and 

maintain a consistent look throughout your site, a look that survives any 

typographical variations that might be introduced by your site visitor’s browser.

Figure 2-6. The Style View

The Style view presents either the Style Gallery or Elements. In the Style Gallery, 

you can select the names of various SiteStyles on the left and view their elements on 

the right. In Elements, you can edit the elements of any SiteStyle, or create your own 

SiteStyle by making your own image files into SiteStyle elements. SiteStyle elements 

include backgrounds, banners, primary and secondary navigation buttons, lines, 

data list icons, and text colors. 
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As a Web page designer, one of your challenges is to design attractive pages that load 

quickly. Text blocks load quickly, but because your visitor’s browser and platform 

control the font and size in which text is displayed, you cannot rely on text blocks to 

establish visual themes for your pages.

With SiteStyles, you can choose any font on your system for banners and buttons. At 

publish time, NetObjects Fusion dynamically generates bitmapped image files for 

banners and buttons using the font you specified for each element. This means all 

your site visitors will see the fonts you specify for banners and buttons, regardless of 

their browser or fonts installed on their systems.

The Assets View
The Assets view gives you centralized control over referenced elements of your site. 

When you change a referenced element in Assets view, NetObjects Fusion updates 

every reference to that element throughout your site. For example, if your company 

gets a new logo, you just replace the old logo’s file with the new one in Assets view 

and NetObjects Fusion automatically updates every page that displays the logo. 

Referenced elements include:

● Files, such as image and rich media files

● Links, including internal, external, and “smart” links

● Data Objects, which reference database information

● Variables, which let you control text that you want to update regularly, such as 
the date the site was most recently updated
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Figure 2-7. The Assets View

Assets view helps you test your site and keep it trim. With a single command, you 

can verify whether the destinations of all the links in your site actually exist. Other 

commands let you check whether referenced files are still in use, and delete any that 

are not. It also helps you fix broken links and restore lost files.

The Publish View
In Publish view, you configure your file transfer settings and transfer your site to a 

local or remote server. 

Click to switch 
between viewing files, 
links, data objects, 
and variables.

Click to add a new asset.
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replace an asset 
throughout your 
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Figure 2-8. The Publish View

You use the Settings... button and the Configure Publish dialog it displays to specify 

two publish configurations: one for your local staging server, the server on which 

you test your site; and one for your remote Web server, the server from which site 

visitors will access your site. For each configuration you can choose whether to 

publish all the assets of your Web site or only those that have changed since the last 

time you published. 

Once you complete the configurations and your site is ready for publishing, simply 

click the Stage or Publish button. NetObjects Fusion generates your site as a series of 

HTML pages and associated files, then uses File Transfer Protocol (FTP) to post 

them to the folder on the server you designated in the configuration. 

When you select publish modifiers, NetObjects Fusion can simultaneously generate 

multiple renditions of the same site:

● text only, for site visitors who prefer to browse in text mode

● greyscale, for site visitors who use a monochrome monitor

Click 
Settings… 
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generating 
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Stage or publish with a single click.
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● low bandwidth, for site visitors who have a slow Internet connection

NetObjects Fusion Navigation
You can navigate among different views and pages using buttons on the control bar, 

menu commands, keyboard shortcuts, and page navigation controls.

The control bar offers these navigation buttons:

To search the entire site for any named NetObjects Fusion element such as 

a page, a layout, or data list, click the Go To button and enter the name of 

the element you want to see.

To return to the previous view, click the Last button. Click Last again to 

redisplay the original page or view. When performing a task that involves 

editing two pages, use this button to switch quickly between them.

Commands on the Go menu help you navigate among the five NetObjects Fusion 

views and the pages of your site. The Go menu presents the keyboard shortcuts for 

its navigation commands.

Figure 2-9. The Go Menu for Windows

In the Site view, you can double-click a page icon to go to the Page view of that page. 

When in the Page view, you can switch to a different page without returning to the 

Site view by using structural navigation aids. Relative to the site structure you built 

in Site view, these aids let you move to the page above or below, or to the left or right 
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of the current page. Structural navigation is available via four Go menu commands, 

their shortcuts, or the page navigation buttons. So, to go to the first child page of the 

current page, you can do any of the following: choose First Child from the Go 

menu, holding down the Alt (Windows) or z (Macintosh) key and press the down 

arrow key, or click the down-arrow page navigation button. 

Figure 2-10. Page Navigation Buttons

Preferences
You open the Preferences dialog with the Preferences command in the Edit menu.

In this dialog, you can:

● turn Auto Save on or off

● set the option to maximize the window at start-up

● set the option to preview the entire site or only the current page

● choose the default Web browser for previewing

● select between a tighter compatibility with the text spacing interpretations of 
Netscape or Microsoft browsers
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● select an application or utility to edit your external HTML pages

● choose a proportional and monospace font to apply across your site (These are 
set by default to work best with Netscape Navigator 3.0 and Microsoft Internet 
Explorer.)

● select a default page width and height

● establish a background image offset for better page display in browsers

● set the option that lets you drag MasterBorder boundary lines to set margin size. 

You can change your preferences whenever you want. Changes take place 

immediately and remain in effect for that site until you change them. Changes apply 

only to the current site.

The NetObjects Fusion Folder Structure
The NetObjects Fusion 2.0 folder contains all the files you need to use NetObjects 

Fusion. 

Figure 2-11. The Default Installation folder for Windows

Do not move or rename the NetObjects Fusion 2.0 folder or any folders within it. 

NetObjects Fusion performs best when the application and its parts remain in the 
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folder recommended during installation. The subfolders organize files according to 

their use:

● NetObjects System contains files used by the program; do not delete or remove 
these files.

● Parts contains design parts such as image files and animated GIFs, as well as 
plug-in parts such as rich media files and Java applets. 

● Styles contains a separate folder for each SiteStyle, including the ones you create. 
NetObjects Fusion Style files have a .ssf extension. 

● Templates contains AutoSites and Page templates. A NetObjects Fusion 
Template file has a .nft extension and its own Assets folder. 

● Tutorial includes the files you need to follow the tutorial provided in Chapter 3. 

● Components contains the NetObjects Fusion Components, which are mini-
applications that can add sophisticated functions to your site.

● User Sites contains all the sites you create. NetObjects Fusion automatically 
creates a new subfolder within User Sites to keep your projects organized. Each 
NetObjects Fusion site is saved with a .nod extension.

More Resources for Site Designers
NetObjects Fusion offers a wide range of resources to help you build your site. The 

following sections offer definitions and descriptions of the ones you will probably 

use most frequently.

Links

You can add links to virtually any content element, such as text, drawn shapes, and 

pictures, regardless the element’s location on a page. NetObjects Fusion supports 

four kinds of links:

● External links are Universal Resource Locators (URLs) that jump to other Web 
sites, newsgroups, and e-mail dialogs. 

● Internal links are links to other pages or anchors within pages of your 
NetObjects Fusion site. 
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● Anchors are links to a specific position within a single page. An anchor lets your 
site visitor jump to a specific location on a long page without scrolling. 

● Smart links navigate in reference to your site’s structure. For example, you can 
use smart links to create Next and Previous buttons to help your site visitor 
navigate a sequence of pages, such as an on-line book or product catalog. 

Navigation Controls

Making your Web site easy for site visitors to navigate is vital for achieving a user-

friendly site. Site visitors need to know where they are and how they can go 

elsewhere. NetObjects Fusion automatically creates two kinds of navigational 

controls that help your site visitors understand your site’s organization and navigate 

through it: 

● A Banner identifies the page on which it appears by name. 

● A Navigation bar presents buttons that are linked to pages at the level of the site 
you choose. 

You can choose whether banners and navigation bars are displayed horizontally or 

vertically. They can appear in a page’s MasterBorders area, in its layout area, or both. 

NetObjects Fusion automatically updates the navigational controls as you change 

the structure of your site or rename your pages. By default, banners and buttons 

refer to pages by the names you assign in Site view. You can assign custom names to 

be used in banners or buttons if you like.

Navigation buttons can be graphical or text-based. SiteStyles offer two levels of 

button images so you can use them to distinguish different levels of your site. You 

can easily edit a navigation bar’s settings in the Properties palette to mix and match 

SiteStyles, specify borders and spacing, choose the level to which its buttons should 

be linked, and more.

Scripting

Through NetObjects Fusion’s scripting interface, you can easily add HTML tags, 

JavaScript or Visual Basic® script syntax to any element on the page or to the entire 

page.
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Database Publishing

NetObjects Fusion’s data publishing capabilities let you store text and images in a 

database internal to your site, or, if you’re working on the Windows platform, 

import data from external sources such as Microsoft Excel, Access, and ODBC 

databases. In either case, NetObjects Fusion publishes your data in standard HTML 

pages. This makes it easy to add listings such as product and service catalogs, 

employee directories, and event schedules to your site.

Each record in your database is published on a stacked page. Each stacked page 

corresponds to a row in a data list. A data list appears on the parent of the stacked 

pages, and like a table of contents, acts as an index for your stacked pages. Data 

objects are collections of data fields. For example, to publish a product catalog, you 

would use a product data object with the following data fields: name, price, and 

photo. The actual data for the fields could be entered manually in NetObjects 

Fusion or drawn from an external desktop database or ODBC database connection.

Figure 2-12. Data Publishing
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NetObjects Fusion lets you create Next and Previous buttons to automate 

navigation between stacked pages. Chapter 7 of the NetObjects Fusion 2.0 User Guide 

explains data publishing in greater detail.

AutoSites and Page Templates

NetObjects Fusion includes pre-built templates—AutoSites and Page templates—to 

give you a head start with your site construction. 

AutoSites are fully structured sites that can be used on their own, or inserted into 

your existing site as a section. Choose among company sites, on-line publication, 

marketing department, and more. AutoSites help you learn how to build sites and 

save you time with suggested content, consistent layouts, and links. 

Page templates are single pages that can be used separately or inserted into your site. 

Choose among templates for forms, frequently-asked-questions page, and more. 

Visit the NetObjects Web site, www.netobjects.com, to download new NetObjects 

Fusion templates as they become available.

Design Parts

NetObjects Fusion also includes design parts and plug-in parts to jump start your 

site and page design. Design parts include collections of animated GIFs, arrows, 

calligraphic alphabets and numerals, flourishes, motif shapes, navigation buttons, 

textures, symbols, and more that are custom-made for Web publications. Plug-in 

parts are interactive media, such as Shockwave files, sounds, and Java applets, that 

add additional flair to your site. 

NetObjects Fusion Components

NetObjects Fusion Components provide pre-packaged, sophisticated drag-and-

drop solutions to add functionality to the sites you build with NetObjects Fusion. 

Until now, adding a rotating advertisement billboard or a user discussion message 

board required sophisticated programming and knowledge of scripting. With 

NetObjects Fusion Components and a few simple button clicks, you can add these 

and other sophisticated functionality to your site. See the NetObjects Fusion 2.0 User 

Guide to learn how to use each of the NetObjects Fusion Components.
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Learning NetObjects Fusion 3

This chapter guides you step-by-step as you create your first site with NetObjects 

Fusion. The lessons take you through

● constructing a site

● saving and opening your site

● designing a page

● changing the SiteStyle

● adding pictures and assets

● previewing the site

● creating an imagemap

● creating a new MasterBorder

● creating navigation bars and frames

● importing an existing HTML page

● inserting a NetObjects Fusion Page template

● exploring and adding form elements

● adding a text link

● database publishing

● managing assets

● staging the site

To perform all the steps in this tutorial you some sample files. They are installed 

automatically with the full version of NetObjects Fusion 2.0 for Macintosh. If you 

did not choose the full installation, use the NetObjects Fusion installer’s Custom 

Install option to install just the tutorial files. Windows versions of the tutorial files 

are available on the NetObjects Web site. If you do not have the tutorial files, you 

can still follow along to learn NetObjects Fusion’s key features.
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Each lesson in this chapter demonstrates a key feature and suggests “Next Steps” you 

can follow to explore related features on your own, if you like. The lessons assume 

you have completed the tour in Chapter 2.

This tutorial is based on the following scenario:

You’re to design a Web site for your employer, radio station KVYB—“The Vibe”—

105.7 on your FM dial. The Vibe wants a strong presence on the Web to provide 

access to its schedule of events, playlist, and on-air personalities. The station also 

wants to obtain listener feedback and mailing list data, and to promote advertising 

sales. You just bought NetObjects Fusion, and you’re ready to build the site.

Constructing a Site
Your Home page is to provide access to the four major sections of your site: Events, 

Music, Us, and Listeners. You will start by creating the site’s hierarchical structure, 

consisting of the Home page and the other four pages. Then you’ll explore tools for 

viewing your site structure and managing pages.

To construct site structure

1. Start NetObjects Fusion and start a new site.

● If you’ve never opened NetObjects Fusion before, the New Site 

dialog appears automatically.

● If NetObjects Fusion was previously opened, the last accessed site 

appears. In this case, to display the New Site dialog, choose New Site 

from the File menu.
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The New Site dialog gives you options to open a blank site, or to create a 
new site based on an AutoSite template or another template, such as a 
page template. You can also import an existing site—either from your 
local computer or over a network connection. 

2. Select Blank site, type “KVYB” in the Site Name field, then click OK.

The Site view appears, displaying an icon of the Home page. Notice that 
the Site view button in the control bar is highlighted to let you know 
you’re in the Site view. The Site view also displays the Tools palette and 
the Properties palette.
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3. To create your site’s structure, click the New Page button in the control 
bar four times.

Four new pages are added to the site, each a child of the Home page.

Whenever you click the New Page button, NetObjects Fusion adds an 
Untitled child page to the selected page in Site view. You can add as many 
pages as you want.

NetObjects Fusion uses page names to build buttons and banners that 
help visitors navigate your site. So now you’ll give the pages meaningful 
names.

4. Click the word Untitled in the page icon on the left.

The page name becomes highlighted.

5. Type “Music” to rename the page, then press Enter or Return.

The Properties palette displays the Page tab, and the new name appears 
in the Name field.

Properties palette

The name of your site

Control bar
Secondary control bar

New Page button

Page icon Tools palette
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6. Select the next page name.

When a page name is selected, pressing the Tab key cycles you from 
name to name across a level of pages. You can either use the Tab key or 
click with your mouse to select a page name.

7. Change the remaining page names to “Events,” “Us,” and “Listeners.”

Now that your site has a structure, you can explore the different ways 
you can view it, as well as the tools you can use to manage pages.

To view site structure and manage pages

1. Click the Outline View button in the secondary control bar to display an 
outline version of your site. 

2. Select the Home page icon to display additional information about each 
child page. 

The blue outline 
around the page icon 
indicates the page is 
selected. 
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3. Click Structure View to redisplay the site structure map.

4. Select the Zoom Out tool, then click anywhere on the screen to reduce 
the size of the page icons. 

This can help you view and move around large sites. 

5. Select the Zoom In tool, then click anywhere to restore standard size. 

6. Reselect the Select tool, then click the small triangle under the Home 
page to collapse the view of its child pages. Click the Plus sign to expand 
the view again. 

7. Select a page, then in the Page tab of the Properties palette, change the 
status to Done, select the Don’t Publish option, and enter some 
comments. 

● When you click the Done option, a check mark appears in the 

upper-right corner of the page icon, indicating its status. The Status 

setting and the Comments are for your information only. They do 

not affect the pages themselves. Use these features to keep track of 

pages that are finished, or to track the open issues of those still 

under development.

● When you click Don’t Publish, a red bullet appears in the page icon. 

Pages marked Don’t Publish will not be included when you publish 

your site. Use this feature to prevent unfinished pages from being 

published before they’re ready.

Done check mark

Don’t Publish bullet
3-6 Learning NetObjects Fusion



S A V I N G  A N D  O P E N I N G  Y O U R  S I T E
8. Set all pages to Publish to continue the tutorial.

This is a good time to learn about saving your site. 

Saving and Opening Your Site
NetObjects Fusion automatically saves your site as you work, because the Auto Save 

option in the Preferences dialog is set by default. Because this tutorial encourages 

you to experiment with NetObjects Fusion features, you will turn off the AutoSave 

option so you can manually save your site only when it is the way you want it. This 

way, you can abandon changes when you don’t want to keep experimental elements 

in your site.

To turn off Auto Save

1. Select Preferences from the Edit menu.

The Preferences dialog appears.

2. On the General tab, click the Auto Save check box to clear it, if it is not 
already cleared. 

The Auto Save feature is now turned off.

3. Click OK to close the dialog.

Now you will save your site manually.

To save your site

◆ Select Save Site from the File menu.

NetObjects Fusion saves your site in the NetObjects Fusion 2.0\User 
Sites\KVYB folder, with the name KVYB.nod.

Now you will learn how to abandon changes and exit without saving.

To abandon changes

1. Select Exit (Windows) or Quit (Macintosh) from the File menu.
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A dialog appears asking whether you want to save changes to your site 
before closing. 

2. Click No.

NetObjects Fusion closes without saving changes you made since you 
last saved the site.

When you are ready to continue the tutorial, you can open your site 
again.

To open your site

1. Start NetObjects Fusion.

The last accessed site appears on your screen.

● If this is your site, you are ready to continue.

● If it is a different site, select KVYB.nod from the numbered list of 

recently opened sites in the File menu. 

● Or, if your site is not in the list, you can select Open Site from the 

File menu. In the file open dialog that appears, navigate to 

NetObjects Fusion 2.0\User sites\Kvyb, select KVYB.nod, and 

click the Open button.

Note: If, after you create a site, NetObjects Fusion displays the New Site 
dialog when you start the program, select the Blank site option, type a 
name in the Site Name field, such as “Test,” and click OK. When the new 
blank site appears, use one of the methods described above to open your 
site.

Next Steps. In Site view, try adding some pages. Add pages to those pages. To 

rearrange your site, drag a page icon over another page. A red arrow appears to 

indicate on which side the page will land when you drop it.

Try color coding the pages by clicking the Color button in the Page tab of the 

Properties palette, selecting a color, and clicking OK. This is a good way to keep 
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track of which pages are done and which are still being worked on, or who is 

responsible for particular pages.

When you are finished, delete the extra pages. To delete a page, select it and press the 

Delete key. Or simply abandon your changes by exiting NetObjects Fusion without 

saving.

Designing a Page
Now that your site structure is started, you can add content to the individual pages. 

You’ll start with the Music page.

To design a page

1. To open the Music page, click the Music page icon to select it, then click 
the Page button, or just double-click the Music page icon.

NetObjects Fusion displays the Page view for the Music page.

Banner with page 
name

Navigation bar 
with graphical 
buttons

Layout area

Navigation bar with 
text buttons

Page navigation 
buttons

MasterBorder
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NetObjects Fusion has already added elements to the Music page via the 
default MasterBorder, which you can see in the margin areas outside the 
Layout area. The default MasterBorder includes a horizontal banner, a 
vertical navigation bar, a horizontal text navigation bar, and the Built 
with NetObjects Fusion icon. 

The horizontal banner already displays the name you gave to this page in 
the Site view. Buttons in the vertical navigation bar are already linked to 
the other pages you have created.

NetObjects Fusion automatically creates a text navigation bar in the 
bottom margin so that site visitors whose browsers do not display 
graphics can navigate your site. The text navigation bar also helps site 
visitors to navigate quickly from the bottom of a page.

2. Click the View tab on the Properties palette, and make sure there is a 
check mark in the Show Element Borders check box. 

3. Select the Text tool. 

4. Drag a bounding box anywhere in the Layout area.

By default, text boxes grow and shrink to accommodate just the text they 
contain. The text box will shrink after you finish typing and unselect it. 

5. Now type the following:

Welcome to The Vibe. 

Text tool

Insertion point 
in the text box
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Our music is the hottest collection from a variety of genres. 

As you type, the text box grows if needed to accommodate the text.

While the text box is selected, the Properties palette displays the Text tab, 
ready for you to make any changes you want. Notice you can change the 
alignment, font, size, and style of text. You can also set the text color and 
the background color.

6. Click the text block on any edge, so that the handles are solid, and drag it 
to align with the first grid line from the left and the first grid line from 
the top of the Layout area.

If Grid lines are turned off, click the View tab and select Show Grid to 
turn them on.

If you want to resize the text box, drag a corner handle. The line breaks 
automatically adjust to fit.

7. Save your site.

You’ve just seen how to work with NetObjects Fusion pages. You’ll add other 

content later, but you will always do so in the same way:
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1. Click the tool you want to use.

2. Drag a bounding box in the NetObjects Fusion window.

3. Enter the content of the element.

4. Click the bounding box and reposition it anywhere in the window.

5. Save your site.

Next Steps. To see how NetObjects Fusion automatically updates the navigation 

controls in the MasterBorders, return to Site view and add or rearrange pages in the 

site structure. Return to Page view to check the result. If your changes are extensive, 

abandon them before continuing.

Changing the SiteStyle
As you look at the Music page, you see that it does not match Vibe’s corporate 

image. It’s time to take a look at the selection of SiteStyles available in NetObjects 

Fusion.

To change the SiteStyle

1. Open the Style view by clicking the Style button.

NetObjects Fusion displays the Style view. 
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The secondary control bar displays the name of the SiteStyle currently in 
use—in this case, Plain. A list of available SiteStyles appears in the 
scrollable list on the left. The elements of the SiteStyle selected in the list 
appear on the right.

2. Look through the different SiteStyles in the list. 

When you select a name in the list, the display on the right shows the 
banner, button, bullet, text styles and line styles for that SiteStyle.

3. Finally, select Vibe. 

Vibe is the SiteStyle designed by the station’s art department.

4. Click the Set Style button in the secondary control bar. 

The current SiteStyle name changes to Vibe, which means these elements 
automatically appear on all your pages.

5. Click the Page button.

The Music page reappears. Its automatic navigation elements are now in 
the Vibe SiteStyle.

Current SiteStyle

Set Style button

Selected SiteStyle
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6. Save your site.

Next Steps. Try editing one of the SiteStyles. Return to Style view, select a SiteStyle, 

then click Elements in the secondary control bar. In the list on the left, double-click 

a SiteStyle element, then make whatever changes you want. You can change colors, 

substitute one picture for another, change fonts, change backgrounds, and so on. 

The changes you make will be carried forward into sites you create in the future. 

Note: NetObjects Fusion saves SiteStyle changes regardless of whether Auto Save is 
turned on or off in the Preferences dialog. To undo your changes, you must reselect 
the original options yourself.

For complete instructions on editing SiteStyles, see “The Style View” in the 

NetObjects Fusion 2.0 User Guide.

Return to the Music page to continue the tutorial.

Adding Pictures and Assets
Even with text and navigation aids, your Music page looks bare. You decide to add 

the station’s logo to the page.

To add a picture

1. Select the Picture tool and under the text block, draw a bounding box for 
the picture.

The size of the box does not matter; NetObjects Fusion will 
automatically adjust the box to fit the picture after you select it.

NetObjects Fusion displays a file open dialog so you can locate the image 
you want to place in the picture box. 

2. Navigate to Vibe’s image artwork in NetObjects Fusion 
2.0\Tutorial\Assets. 

If you like, you can set the option to view thumbnails of the images.
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3. Choose how to add the picture.

● On a Windows system, select the Folders tab in the Image File Open 

dialog. 

● On a Macintosh system, select the New from File option in the 

dialog’s pop-up menu. 

Typically these options are selected by default. You want to be sure the 
Folders tab or the New From File option is chosen because you are 
adding a new asset to your site. You’ll use the Image Assets tab or New 
From Asset option when you place this image again. 

4. Select Antenna.gif and click Open.

The logo appears on the Music page.

5. Navigate to the Events page, select the picture tool, and draw a bounding 
box.

Folders tab 

New From File option
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In the image file open dialog appears. 

6. Choose either the Image Assets tab (Windows) or the New From Asset 
option (Macintosh), then choose the Antenna asset and click Open.

The antenna appears on the Events page.

Using assets you’ve already created helps keep your site trim and makes 
it easy to replace one image with another, as you’ll see when you explore 
Assets view later in this tutorial.

7. Navigate back to the Music page, then save your site.

Previewing the Site
Now you are ready to check how your site will look to a visitor. You will use Preview 

to review and test your site in a browser.

To preview your site

1. Choose Preferences from the Edit menu.

NetObjects Fusion displays the Preferences dialog.

2. In the Preview section, select the browser you want to use to Preview 
your site.
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On a Windows system, the list automatically includes all the browsers 
installed on your system. On a Macintosh, use the Add button to add 
browsers to the list.

Notice that by default, Entire Site is selected in the Preview section of the 
dialog. While this option selected, you can still choose to preview only 
the current page by holding down the Control key when clicking 
Preview.

3. Select the WYSIWYG Optimization option that matches the browser 
you selected.

Netscape Navigator and Windows Internet Explorer use different line 
spacing when displaying text. NetObjects Fusion will use the line spacing 
of the browser you choose here to display text in Page view. If you are 
using a browser other than Netscape Navigator or Windows Internet 
Explorer, try both options to determine which one you like best. 

4. Click OK to close the dialog.

5. Click the Preview button in the control bar.

NetObjects Fusion automatically launches your browser and displays 
your page as it will appear on the Web.

The following illustration shows the page as it appears in Netscape 
Navigator 3.0. 
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6. Click the navigation buttons to display the other pages.

The banner shows the name you gave each page.

The button for the selected page changes to the highlighted button style 
specified in the Vibe SiteStyle.

7. When you are finished, close or hide your browser.

Next Steps. When previewing your site, NetObjects Fusion performs many tasks 

behind the scenes. It writes HTML files to NetObjects Fusion 2.0\User 

Sites\KVYB\Preview and subfolders within it. For example, it writes assets, such as 

banners and graphical navigation bars, to NetObjects Fusion 2.0\User 

Sites\KVYB\Preview\Assets\auto_generated_images. You can browse these 

folders with your Macintosh Finder or Windows Explorer.

Note: To make the preview process as fast as possible, NetObjects Fusion does not 
create a complete site during preview. What you see in the Preview folder is not 
suitable for Web publication.

Banner

Graphical 
navigation bar

Text navigation bar
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Creating an Imagemap
You’ve decided to place an imagemap on the Home page as the navigation tool for 

your viewers. An imagemap is a picture that contains links to other pages or Web 

sites. These links are called hotspots. To create an imagemap, you first place a 

picture, then add hotspots to it.

To create an imagemap

1. Open your Home page in Page view. 

The layout of the page is blank, because you haven’t added anything to it. 

2. Choose Layout Only from the View menu. 

This hides the MasterBorders and increases product performance.

You are going to import a picture, developed by your station’s art 
department, to serve as the image for the imagemap.

3. Click the Picture tool, then draw a bounding box in the middle of the 
page.

NetObjects Fusion displays a file open dialog. 

4. Choose the appropriate option for creating a new asset, then navigate to 
and open Imagemap.gif in NetObjects Fusion 2.0\Tutorial\Assets. 

The picture appears in the picture bounding box. 

Drag as needed to center it, then you’re ready to add hotspots.
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5. Click the Picture tool, then click the Hotspot Rectangle secondary tool.

Now you will draw a rectangle to define a “hot” area that will link to 
another location when a site visitor clicks it.

6. Draw a rectangle over the Music icon, including the word “Music” under 
the icon. 

NetObjects Fusion displays the Link dialog. In this dialog, you can 
specify where the link will take your visitor:

● another page in this site (Internal Link)

● another Web site or URL address (External Link)

● a page in relative location to this page in the site hierarchy (Smart 

Link).

The Internal Link tab lists the links NetObjects Fusion automatically 
created when you added pages to your site.

Picture tool

Secondary 
picture tools

 Hotspot 
Rectangle tool
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7. Select the Internal Link tab, then in the Page section, select the Music 
page.

8. Click the Link button.

The Properties palette displays the Hot Spot tab, showing the name of 
the destination page for the selected hotspot link.

When a Web site visitor clicks the hotspot, the Music page will open.

9. Repeat steps 5 through 8 to create hotspots for the Events, Us, and 
Listeners pages.

10. Save your site.

Your imagemap is finished.

NetObjects Fusion generates the links for you. The links are maintained 
no matter where you move the pages in the site structure.

Next Steps. In Site view, rearrange the site structure, then return to Page view and 

observe how links are maintained. Abandon your changes if they’re extensive.
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Creating a New MasterBorder
Because your Home page has an imagemap for navigation, it no longer needs the 

navigation buttons and banner in its margins. In this section you will create a 

unique MasterBorder for your Home page.

To create a new MasterBorder

1. Deselect Layout Only from the View menu to re-display the entire page. 

2. Click an empty space in the Layout area of the page.

The Layout tab appears on the Properties palette.

3. In the Layout tab, click the New button in the MasterBorder section.

The words “Untitled 2” appear in the MasterBorder list. 

You have created a new MasterBorder. Like all newly-created 
MasterBorders, it is identical to the site’s Default MasterBorder. Now 
you can make changes to it that will not affect the Default MasterBorder 
and consequently every page that uses the Default MasterBorder. 

4. Click within the MasterBorder to select it.

The Properties palette displays the MasterBorder tab.

5. In the Name field, rename this MasterBorder to “TopBorder.”

New MasterBorder 
button

List of MasterBorder 
Names
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6. Select the navigation bar on the left side of your MasterBorder and press 
Delete.

If the navigation bar does not disappear, make sure that the selection 
handles are solid and press Delete again. 

7. Select and delete the banner at the top of the page.

Now you will make room for the Vibe masthead.

8. In the Margins section of the MasterBorder tab, type in or press the 
controls on the Top field to change its value to 150.

To add elements to a MasterBorder

1. Click the Picture tool and draw a bounding box in the MasterBorder at 
the top of the page.

A file open dialog appears.

● On a Windows system, select the Folders tab in the Image File Open 

dialog. 

● On a Macintosh system, select the New from File command in the 

dialog’s pop-up menu. 

2. Select the file TheVibeMasthead2.gif, located in NetObjects Fusion 
2.0\Tutorial\Assets, then click the Open button.

The picture appears in the bounding box.

3. Drag the picture so it is centered in the MasterBorder at the top of the 
page.

4. Repeat steps 1 through 3 to place ShortHorizontalLine.gif, located in 
the same folder, under the masthead.

5. Select both elements by dragging a selection box around them.
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6. Align the two selected elements by choosing Center Vertically from Align 
Elements in the Page menu. 

Your new MasterBorder is complete. You can use this MasterBorder on 
any page where you don’t want to display the standard navigation 
controls. Take a look at how to assign it to a new page.

7. Navigate to the Music page, then press the New Page button.

A new Untitled page appears.

8. On the Page properties tab, name the page “Jazz.”

9. Click in the Layout area to expose the Layout properties tab, then from 
the list of MasterBorders, choose TopBorder.

The masthead appears at the top of the page. 

10. Restore the Default MasterBorder if you like, then save your site.
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Creating Navigation Bars and Frames
You just started a second level in your site, to which you’ll add more pages in 

subsequent lessons. Your visitors will need a way to navigate to the second level. So 

you decide to add a second navigation bar to your site’s Default MasterBorder. This 

will add length to your navigation aids, so you decide to convert your left 

MasterBorder into an AutoFrame.

To add a navigation bar

1. Display the Music page in Page view.

2. On the Tools palette, select the Navigation Bar tool, then in the 
secondary tools area, select the Vertical Navigation Bar tool.

3. In the left MasterBorder, drag a bounding box for the new bar just under 
the existing navigation bar.

The new bar appears, and the Nav Bar tab is exposed on the Properties 
palette. The new bar is identical to the one above it. Now you’ll modify it 
to display buttons for child pages.

4. On the Nav Bar tab, click the Set... button.

The Nav Bar Display dialog appears.

Navigation Bar tool

Vertical Navigation Bar 
tool
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5. Select the Child Level option, and clear the Include Home Page option.

6. Dismiss the dialog.

Now the new navigation bar shows just one button: Jazz. If needed, you can 
drag or use the Align Elements, Center Vertically command to center it 
under the first bar.

To create an AutoFrame

1. Click in the MasterBorder of the Music page. 

This exposes the MasterBorder properties tab.

2. In the AutoFrames section of the tab, click the Left button, and make 
sure the Generate HTML frame borders option is selected. 

The new frame has a dark orange label and border.

3. Click inside the Left AutoFrame and expose the Frame properties tab. 

4. In the User Scrollable Frame section of the tab, select Yes, and if you like, 
set the User Resizable Frame option.

5. Save your site, then click Preview to view your first-level pages with 
scrollable, user-resizable AutoFrames. 

Next Steps. Add sibling pages to the Jazz page and watch the second navigation bar 

grow. Select the second navigation bar, then on the Nav Bar properties palette, select 

the Secondary Buttons option. The different-shaped buttons can cue your visitors 

that they link to a lower level of the site. 
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Navigate to the other pages and look at the second navigation bar. Because the 

Events, Listeners, Us, and Jazz pages do not have children, the second navigation bar 

has no buttons on these pages. NetObjects Fusion will add buttons when you add 

child pages. If you never add child pages, the bar remains empty and you’ll see no 

secondary buttons when you preview or publish.

Working with Existing HTML Pages
One of your favorite recording artists will be giving a concert and you’ve decided to 

list this on your Events page. In fact, the artist’s management has supplied you with 

an announcement in HTML format. 

To import an existing HTML page

1. Go to Site view and add a new page under the Events page.

A new Untitled page appears under the Events page.

2. Name the page “Concert.”

3. Open the Concert page in Page view. 

4. Click in the Layout area of the Concert page, then select the Import Page 
command from the File menu.

A file open dialog appears, with the filename filter set to *.htm and 
*.html. 

5. Navigate to and select Concert.htm in the NetObjects Fusion 
2.0\Tutorial\Assets\HTML Page folder, then click the Open button.

NetObjects Fusion converts the HTML file into its own internal format 
and the page’s elements appear in the Layout area. 

You can move and edit elements on the page as usual. The original 
Concert.htm file remains unchanged.

6. Save your site and preview the page. 

Next Steps. Because this page comes with a title, you might want to publish this 

page without a banner. Create a new MasterBorder, name it “Concert,” delete the 

banner, and preview the page. 
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Inserting a NetObjects Fusion Page Template
You convinced your assistant to work on a Feedback page while you went to lunch. 

Now that you are back, you are ready to insert the Feedback page into your site and 

take a look at it. Your assistant created a NetObjects Fusion Page template for you to 

import, which is how you exchange pages with other NetObjects Fusion users. 

Template files take on the SiteStyle of the site into which they are inserted.

To insert a page template

1. Go to the Site view and select the Listeners page.

You select the Listeners page so that the Feedback page will be attached 
to it. When you import a page template or section, it becomes a child of 
the selected page.

2. Choose Import Section from the File menu. 

The Import Section dialog appears. 

3. In the NetObjects Fusion Sites section, select Other. Then, on a 
Windows system click Browse, and on a Macintosh system click Select.

An open file dialog appears listing template files.

4. Select Feedback.nft, located in the NetObjects Fusion 
2.0\Tutorial\Feedback folder, and click the Open button.

All NetObjects Fusion template files use the .nft extension. 

5. In the Import Section dialog, click OK.

The new page appears under the Listeners page. The page has the same 
name it had in your assistant’s site: Feedback.
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6. Double-click the Feedback page icon to open its Page view.

NetObjects Fusion displays the Feedback page. This page is designed to 
let the site visitor type in information that is saved to a text or database 
file on the server. Your Web server administrator can then retrieve this 
information for you.

7. Click in the Layout area of the imported page and select the Default 
MasterBorder in the Layout tab of the Properties palette. 

8. Save your site.

Next Steps. Experiment by importing another page template. This time, select one 

of the NetObjects Fusion Page Templates from the Page Template list in the Import 

Section dialog. If your experiments are extensive, abandon your changes.

Exploring Form Elements
To create the Feedback page, your assistant used several of the form elements 

available in NetObjects Fusion. Before you add your own form element, take a 

closer look at those already on the Feedback page.

To view form element properties

1. Select the input box for “first name.”
Learning NetObjects Fusion 3-29



E X P L O R I N G  F O R M  E L E M E N T S
The Single Line tab in the Properties palette shows the options for a 
single-line form element. This means the box you selected is a single-line 
edit field that accepts up to 60 characters entered by the site visitor. 

2. Click the large empty box that appears under the text “What do you 
think of KVYB?” 

The Multi-Line tab appears in the Properties palette, showing that this 
box is a multiple-line edit field named “tell.”

Like the single-line form, the multiple-line form field also lets a site 
visitor enter text. However, a multiple-line field can accept more 
characters and will offer scroll bars if the typed text exceeds the visible 
height of the box.

Next Steps. Before this form can become active, you will need to do some behind-

the-scenes wiring. A form requires a CGI (Common Gateway Interface) script to 

process the site visitor’s input. This script must be associated with the Submit 

button. You can use either your own or a third-party CGI script with the Submit 

button shown here, or you can take advantage of the NetObjects Fusion AutoForm 

Component for handling forms. Please refer to the NetObjects Fusion 2.0 User Guide 

for information on the NetObjects AutoForm Component. 
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Adding a Form Element
Your assistant has left it up to you whether you want to offer your site visitors a 

static list or a drop-down menu to choose their favorite kind of music. You decide to 

use a drop-down menu to offer them the choice of jazz, classical, or hard rock.

To add a form element

1. Click the Forms tool.

The form element buttons appear in the secondary tools palette.

2. Click the Forms Combo Box tool and draw a rectangle beneath the 
“What’s your favorite form of music?” text box.

An empty drop-down list box appears on the form, and NetObjects 
Fusion displays the Combo Box tab in the Properties palette.

3. To name the form object, type “music choices” in the Name field of the 
Combo Box tab.

4. Click the Dropdown List radio button. 

Forms tool

Secondary forms 
tools Forms Combo 

Box tool
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The combo box becomes a drop-down list that fits in the available space.

5. To add your first menu item, click the large “+” symbol button in the 
Elements section of the Combo Box tab.

NetObjects Fusion displays the Enter Value dialog.

6. Type “Jazz” in the Name field and enter “1” in the Value field. 

“1” is suggested as an example value. To make your form work, you must 
enter the value required by the CGI script that will process the form.

The name will appear in the drop-down list when you preview or 
publish your site. 
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When your site visitor presses the Submit button, the CGI script sends 
the value you entered to your Web server, along with values from other 
fields in the form.

7. Select the Selected by Default option to make Jazz the default choice in 
the list.

8. Click OK.

9. Repeat this process to enter the following:

You can double-click an element in the Combo Box tab to edit it.

10. Save your site.

11. Click the Preview button on the control bar to view this page in your 
browser.

Name Value

Classical 2

Hard rock 3
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Next Steps. Experiment by adding a check box to this Feedback form. Click the 

Forms tool, click the Forms Checkbox secondary tool, draw a bounding box, and 

then fill out the properties tab.

Adding a Text Link
Now that you have attached your Feedback page to the Listeners page, you decide to 

add a text link to give your listeners an extra, highly-visible way access to the page. 

You will create a link for text on the Listeners page, using a process very similar to 

making a hotspot on a picture. 

To add a text link

1. Navigate to the Listeners page in Page view.

2. Using the Text tool, create a text block that contains this text:

Sign up for our email list! 

3. Select the whole sentence, then choose 24 (+3) from the Size list on the 
Text properties tab. 

To select the sentence, click in the text box so the handles are hollow and 
the insertion point is visible, then drag to select the text. 

4. Now select the words “our email list.”

You will create a link that links just that part of the text.

5. Click Link... in the Text properties tab.

The Link dialog appears, showing the Internal Link tab. 

6. In the Page section of the Internal Link tab, select the Feedback page, 
then click the Link button.

NetObjects Fusion displays the selected text in the Regular Link Color 
defined by the current SiteStyle, which in the Vibe SiteStyle is red. If you 
want to change the color of your linked text, you can do so in Style view.
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7. Save your site.

Next Steps. You might want to experiment with anchors. An HTML anchor lets 

your site visitors jump to a specific location in a long page without scrolling. Your 

NetObjects Fusion 2.0 User Guide tells how to create anchors. 

Database Publishing
The station has decided to add contact information for their Advertising sales staff 

to the site so that potential advertisers can start their ad campaigns quickly. You will 

enter the information and create a layout for it.

To add database records to your site

1. Display the Us page in Page view.

Linked text is underlined 
and displayed in a 
different color.
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2. Select the Data List tool and draw a rectangle in the Layout area.

The Data Publishing dialog appears. 

3. Click the New... button at the top.

The Data Object dialog appears.

4. In the Name field, type “Staff,” then click the “+” button.

The Data Field dialog appears.

5. Type “Name,” select the Simple Text option, and click OK.

The field you created appears in the Data Object dialog.

6. Create two more fields with the following names and types:

Name Type

Title and Duties Formatted Text

Picture Image File

Data List tool
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Your Data Object dialog looks like this:

7. Dismiss the Data Object dialog.

The Data Object field at the top of the Data Publishing dialog identifies 
the data object you just created: Staff. Now you will enter options for the 
creation of your data list and stacked pages.

8. Select Name from the Sort By list.

The data list will appear in alphabetical order by name.

9. Type “Members” in the data list Name field, then click the check box 
next to the Name field. 

The data list will contain only the Name field.

10. Select the two options for creating stacked pages: Display all fields and 
the Add navigation buttons.
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NetObjects Fusion will place the data field elements, labels, and 
navigation buttons on the first stacked page for you.

11. Click OK.

The data list appears on the Us page. Although you can’t see it, NetObjects 
Fusion has created your first stacked page as a child of the Us page.

A data list never displays data in Page view. After you enter data on 
stacked pages, the data list will display names when you preview or 
publish your site.

12. Navigate down to the first stacked page.

13. Click the Page properties tab and name the page, “Who Can Help.”
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Here’s the simple layout NetObjects Fusion created for you.

If you don’t see the rectangles, confirm that the Show Element Borders 
option is selected on the View properties tab.

Notice the red element borders. These highlight data fields, where you 
can enter data.

14. Drag the rectangles to rearrange them as you wish. 

For example, you might set different text options for the labels, or 
choose different button images from NetObjects Fusion 
2.0\Parts\Design Parts or NetObjects Fusion 2.0\Tutorial\Ad Team.

15. Select the Name data field, type a name in it, and format it as you wish.

When you select a red rectangle, you can expose the Data Field 
properties tab and check its name. Because the Name field is a simple 
Text field, all characters in it must share the same formatting.

16. Select the Title and Duties data field, enter some text, and format it as 
you wish.

Because the Title and Duties data field is a Rich Text field, you can select 
characters within it and give them unique formatting. For example, you 
could make a job title bold while the duties remain plain.
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17. Double-click the picture field.

A file open dialog appears.

18. In a Windows system, click the Folders tab. On a Macintosh system, 
select New from File from the pop-up menu. Navigate to the NetObjects 
Fusion 2.0\Tutorial\Ad Team folder, select one of the JPG files, then 
click the Open button.

A photo appears in the picture field.

19. To add another person to the roster, click the plus sign on the yellow 
stacked page navigation bar in the secondary control bar.

Another stacked page appears. Notice that this page uses the same layout 
as the first. All stacked pages share the same layout. If you change the 
layout of a stacked page, all stacked pages are changed.

20. Repeat steps 15 through 18 to fill in data for the next person.

You can create as many records as you like. Navigate between them using 
the left and right arrow buttons on the stacked page navigation bar.

21. Save your site.

22. Navigate back to the Us page and click Preview.

The Us page appears in your browser. The data list has as many entries as 
the number of stacked pages you created. The names and button links 
never exist in Page view, so check them out now.

23. Click one of the button links in the data list.

The stacked page for that person appears.

24. Use the Previous, Up, and Next buttons to navigate between the Us page 
and your stacked pages.

Observe how easily your advertising clients can find the Vibe staff 
members they need to contact.

Next steps. You’ve just stored data within your site. A data object defines the fields 

that can store information. Go to Assets view, click the Data Objects button in the 
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secondary control bar, then double-click the Staff data object. In the dialog that 

appears, you’ll see all the fields in the Staff record.

You can add more fields to this data object, or create different data objects with 

different sets of fields. If you’re using a Windows system, you can import data from 

other applications such as Microsoft Excel, Access, SQL and other ODBC sources. 

To learn how, see the “Data Publishing” chapter in the NetObjects Fusion 2.0 User 

Guide.

Managing Assets
Vibe’s art department has developed a new logo. The Assets view will help you 

update all pages in your site that contain the old Antenna logo. You’ll also verify that 

all your links have valid destinations. 

To update a file asset

1. Click the Assets button to open the Assets view.

Assets view opens showing all file assets in your site, sorted by name.

The buttons in the secondary control bar let you view four types of 
assets: files, links, data objects, and variables. The highlighted button 
shows the type of asset you are viewing.

You can sort assets in different ways by clicking any of the column 
heading buttons. Sorting makes it easy to find a particular asset. 
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2. Click the Date column heading button.

NetObjects Fusion sorts the files by date. Notice that the column by 
which the assets are sorted appears in bold type.

3. Drag the dividers between the column headings to change the column 
widths to show more or less information.

4. Sort by Name, by clicking the Name column heading button.

You can view and edit the file information by double-clicking an entry in 
this list.

5. Double-click the Antenna file.

NetObjects Fusion displays the File asset dialog.

From this dialog you can rename the asset, if you want to. Its Pages 
section shows all the pages in your site that use the asset. In the future 
you might find it convenient to go immediately to a referenced page by 
selecting it in the Pages list and clicking Go To.

But now you’re going to replace the Antenna image with another.

6. Click the Browse (Windows) or Select (Macintosh) button.

A file open dialog appears.

7. Navigate to NetObjects Fusion 2.0\Tutorial\Assets, open Tower.gif, 
then click OK to dismiss the File asset dialog.
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For the Antenna file asset, notice that the location column now identifies 
Tower.gif. If you want, you can check the Music and Events pages to see 
that the tower appears on both, then return to Assets view.

8. To see the list of link assets, click the Links button.

9. Click the Type column heading.

Your site includes at least one external link, several internal links, and, 
from your stacked pages, a few structural links. 

10. Double-click an external link.

In the dialog that appears, you can change the link by typing a new 
address or URL in the Link To field. You can also change the link’s name 
by typing a new name in the Name field.

11. Select Verify All Links from the Assets menu.

NetObjects Fusion displays the Verifying Links dialog, and reports the 
results in the Verify Status column. This feature can speed the testing of 
your site—it’s more efficient than checking all its links by hand in your 
browser. A link that can not be validated probably has no valid 
destination. If you site includes one, double-click it and use the Links 
dialog to fix it.

12. Save your site.

Next Steps. Double-click one of the internal links in the list. Click on a page it 

references, then click Go To. 

In Assets view, click the Data Objects button to see the list of data objects in your 

site. Double-click the data object you created and explore its editing options.

Staging the Site
You’ve fleshed out the four main areas of your site, and now other people at the 

station want to see it. You decide to stage it so you can get their feedback.

Like publishing, staging generates final HTML files and sets up asset files and folders 

in final form. It just puts your site in a different place. With NetObjects Fusion you 

maintain separate settings for your private test server and your public Web server. 
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Because staging and publishing are otherwise identical, you can be assured that 

what you test with staging is what you get with publishing.

To stage your site

1. Click the Publish button in the Control bar to go to Publish view. 

2. Click the Settings button.

The Configure Publish dialog appears, showing the Stage tab.

The Stage tab lets you select the location where NetObjects Fusion will 
create the folder with all the elements of your site. 

You can stage locally or remotely. The default location is NetObjects 
Fusion 2.0\User Sites\your_site_name\Stage. 

3. The default settings are fine for local staging, so click Cancel to return to 
Publish view.

4. Click Stage. 

NetObjects Fusion generates your HTML pages and stages your assets 
into the specified folder on your hard drive. 

When finished, NetObjects Fusion alerts you with the message “Local 
Stage is Complete.” 
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You can now browse these HTML pages locally with any Web browser 
software that supports HTML version 3.2. 

Next Steps. To check out your site in your browser, use your browser’s Open 

command to open index.html located in NetObjects Fusion 2.0\User 

Sites\KVYB\Stage. 

Once you’re satisfied with a site, you’ll want to publish it. The Publish tab in the 

Configure Publish dialog lets you tell NetObjects Fusion the location of your public 

Web server. Some of its settings require detailed knowledge of your Web server. Your 

Internet Service Provider (ISP) or your Web server administrator can help you 

complete these settings. The questions you need to ask are described in your 

NetObjects Fusion 2.0 User Guide and the usage notes at www.netobjects.com/

html/support.html.

Where To Go Next
A good place to start is our Web site at www.netobjects.com./html/

customer_gallery.html. Visit the customer gallery to view the work of other 

designers who have created sites with NetObjects Fusion. Now that you know more 

about how these sites were made, you’ll be able to gather some great ideas for use in 

your own Web sites. 

When you start your next site, remember to turn Auto Save back on. And keep your 

NetObjects Fusion 2.0 User Guide close at hand. It provides detailed, indexed 

instructions for using all the features of NetObjects Fusion.
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Upgrading from 
NetObjects Fusion 1.0 to 2.0 4

If you’re stepping up to NetObjects Fusion 2.0 from a previous version, you’ll want 

your upgrade to proceed smoothly. This chapter gives you a head start by describing

● how to bring sites and other assets forward into the 2.0 
environment

● all the new features in version 2.0

Bringing Your Sites and Assets Forward
Upgrading to NetObjects Fusion 2.0 involves more than just installing the new 

software as described in “Installing NetObjects Fusion” on page 1-8. You’ll need to 

bring the sites and other assets you’ve created in 1.0 forward into the 2.0 

environment. This section guides you through the basic steps:

1. How to update your site and backup files

2. How to bring your SiteStyles forward

3. How to bring your AutoSites and other templates forward

4. When and how to remove previous versions of NetObjects Fusion

This discussion assumes you are familiar with NetObjects Fusion: its site files, 

directory structure, SiteStyles, and templates.

Upgrading Your Sites
To upgrade your sites, you’ll copy them from your 1.0 User Sites folder to your 2.0 

User Sites folder. Then you’ll simply open each .nod file in NetObjects Fusion 2.0.

If any of your colleagues use NetObjects Fusion 1.0 for Macintosh or Windows and 

have not yet upgraded, don’t upgrade any sites that contain information you need to 
Upgrading from NetObjects Fusion 1.0 to 2.0 4-1



B R I N G I N G  Y O U R  S I T E S  A N D  A S S E T S  F O R W A R D
send to them via a template. Earlier versions cannot read templates created by 

NetObjects Fusion 2.0.

To upgrade sites to NetObjects Fusion 2.0

1. Use the Windows Explorer, Macintosh Finder or other tool to copy the 
folders of the sites you want to upgrade from your NetObjects 
Fusion\User Sites folder to your NetObjects 2.0\User Sites folder.

2. From within NetObjects Fusion 2.0, use the Open Site command from 
the File menu to open the .nod file of the first site you want to upgrade.

This dialog appears.

3. Click Yes.

NetObjects Fusion upgrades your site’s database and creates a new .nod 
file. The original 1.0 .nod file remains in the folder as a backup. In the 
new .nod file, certain aspects of your site are upgraded to take advantage 
of new features in NetObjects Fusion 2.0. For example, headers and 
footers are automatically converted to MasterBorders so you can easily 
add AutoFrames if you want.

If you encounter a problem upgrading any one site, the fastest solution 
might be to reopen the site in NetObjects Fusion 1.0, export it as a 
template, then open a new site based on that template in NetObjects 
Fusion 2.0.

4. Repeat the steps above until you have upgraded all the sites you want to 
bring forward into NetObjects Fusion 2.0. 

If you created backup files in NetObjects Fusion 1.0 (site files with a .bak 

extension), you can use the NetObjects Fusion 2.0 Open Site command to bring 

them forward also. To make backup files appear in the Open dialog, either choose 
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All Files (*.*) from the Files of Type drop down list in the Open dialog, or rename 

them with the .nod extension before trying to open them.

About Backups: NetObjects Fusion 2.0 includes a Save Site As... command that 

simplifies creating a backup copy of the active .nod file. With this quick and 

convenient backup process, we hope you will make backups frequently. However, 

we recommend that you also occasionally back up your site by exporting it as a 

template. This is because a template includes all your site’s assets, as well as other 

information that can be valuable if problems occur.

Transferring Your SiteStyles
When you install NetObjects Fusion 2.0, the installer program checks your 

computer for other NetObjects Fusion installations, and if it finds any, lets you 

choose any existing SiteStyles you want to bring forward. 

● If you skip this step, or later decide you want to bring forward a SiteStyle you did 
not select during the installation process, you’ll need to bring the SiteStyle 
forward yourself. 

● If you do not skip this step, you might expect that the SiteStyles you selected will 
appear in any new site you create in NetObjects Fusion 2.0. This is not the case. 
The installer only makes SiteStyles easier to import into a specific site by copying 
them to your NetObjects 2.0\Styles folder. 

The SiteStyles available in a site’s Style Gallery are specific to the active .nod file. 

When you create a new site, the .nod file inherits the selection of SiteStyles available 

in the template on which the new site is based. This means if you want a SiteStyle 

you are bringing forward to be available in each new blank site you create, you must 

upgrade your Blank Site template to include that SiteStyle.

Before you begin, review and compare the different SiteStyles available in 

NetObjects Fusion 1.0 and 2.0, and determine which 1.0 SiteStyles you want to 

bring forward. Only three SiteStyles appear in both versions: Vibe, Standard, and 

Plain. In addition to new designs, the difference between the SiteStyles in the two 

versions is that all 2.0 SiteStyle elements support GIF89a transparency, which lets 

them blend smoothly with any background color you select. If you want to upgrade 

a 1.0 SiteStyle to support transparency, use a photo imaging application such as 
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Photoshop or Paint Shop Pro to open each GIF in the SiteStyle’s subfolders and save 

them as transparent GIFs.

To import SiteStyles into NetObjects Fusion 2.0

1. Use the Windows Explorer, Macintosh Finder or other tool to copy the 
folders of the SiteStyles you want to upgrade from your NetObjects 
Fusion\Styles folder to your NetObjects 2.0\Styles folder.

If during installation you selected the SiteStyles you want to bring 
forward, you can skip this step.

2. Use the Windows Explorer, Macintosh Finder or other tool to make a 
backup copy of the default Blank Site.nft that resides in your 
NetObjects Fusion 2.0\Templates\AutoSites\Blank Site folder.

3. In NetObjects Fusion 2.0, open a new blank site and name it Blank Site.

4. Switch to the Style view and import the SiteStyle(s) you want.

● If you’re importing only one SiteStyle, choose Import Style… from 

the File menu, then in the Open File dialog box that appears, 

navigate to and select the .ssf file of the SiteStyle you want to import 

and click OK. The SiteStyle appears in the Style Gallery.

● If you’re importing several SiteStyles, choose Update Styles from the 

Edit menu. NetObjects Fusion updates the Style Gallery to include 

all SiteStyles currently found in the Styles folder. 

5. Switch to the Site view and choose Export Template... from the File 
menu.

6. In the Select Folder dialog that appears, choose NetObjects 
2.0\Templates\AutoSites and click OK.

NetObjects Fusion 2.0 replaces the default Blank Site.nft with a new one 
that includes the SiteSyles you just imported. 
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Upgrading Your Templates
Like a site file, a template you created in NetObjects Fusion 1.0 must have its 

internal database upgraded to work with NetObjects Fusion 2.0. Also, if you want 

convenient access to your template, you must copy it to the appropriate folder in 

NetObjects Fusion 2.0’s directory structure.

To upgrade a template

1. In NetObjects Fusion 2.0 Site view, choose New Site from the File menu.

2. In the New Site dialog that appears, give the site the name you want for 
the upgraded template and select the Other Template radio button. 
Then on a Windows system click Browse, or on a Macintosh click Select.

3. In the Open dialog that appears, locate the .nft file you want to upgrade 
and click Open.

NetObjects Fusion 2.0 converts the template’s database.

4. Choose Export Template... from the File menu.

5. In the Choose Folder dialog that appears, specify a location for the 
template.

The template’s location determines how convenient it will be to access 
from within NetObjects Fusion 2.0.

● If you want to always browse for the template, store its folder 

anywhere except your desktop or root of your hard disk.

● If you want to access the template via the AutoSites drop-down list 

when creating a new site, store its folder in NetObjects Fusion 

2.0\Templates\Autosites.

● If you want to access the template via the Page Templates drop-

down list when importing a site section, store its folder in 

NetObjects Fusion 2.0\Templates\Pages.

6. Click OK.
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NetObjects Fusion creates a new folder in the location you specified, using the site’s 

name as the folder name. Into this folder it places a template file with a .nft 

extension and an Assets folder containing all the assets of the site.

After you’ve opened another site, you can reclaim disk space by deleting the site you 

created in step 3 from your NetObjects Fusion 2.0\User Sites folder.

Removing Previous Versions of NetObjects Fusion
On a Windows system, you can use the Add/Remove Programs utility available in 

the Control Panel to remove previous versions of NetObjects Fusion. On a 

Macintosh system,  drag the NetObjects Fusion folder to the trash, then  drag 

NetObjects Fusion Preferences from the Preferences folder inside your System 

folder to the trash. 

You should immediately remove expired copies of evaluation versions.

We recommend that you remove NetObjects Fusion 1.0 only after you’ve verified 

that all site files, SiteStyles, templates and other assets that you’ve brought forward 

into NetObjects Fusion 2.0 are functioning as you expect. Also, do not remove it if 

any of your site development colleagues use NetObjects Fusion 1.0 for Macintosh, 

or Windows and have not yet upgraded. Earlier versions cannot read templates 

created by NetObjects Fusion 2.0.

New Features in Version 2.0
NetObjects Fusion™ 2.0 for Windows and Macintosh includes over 100 new and 

improved features. Use these lists to identify them and put them to use quickly. For 

directions on how to use a new feature, see the NetObjects Fusion 2.0 User Guide.

NetObjects Fusion Components

NetObjects Fusion Components are a new type of Java-based drag-and-drop 

object that you can place anywhere on your page. The list of components 

available from the secondary tool bar are:

● NetObjects MessageBoard: a full-featured message board running on 
Windows NT and UNIX Web servers
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● NetObjects SiteMapper: an advanced Java-based application for viewing and 
navigating your site.

● DynaButtons: Java-based buttons that have a dynamic state (mouse over, 
pressed, depressed).

● TickerTape: a Java-based applet that gives your Web site visitors a scrolling LED 
tickertape message.

● NetObjects AutoForm: A CGI Script that can be used to allow your Web site 
visitors to send feedback via your Web forms. 

● Rotating Picture: A Java-based applet that displays a rotating image.

● Time- Based Picture: A Java-based applet that displays an image for a specified 
period of time.

● Picture Loader: A Java-based applet that loads an image dynamically at browser 
request from a URL.

New or Improved Features

● Anchors

● Arrow tool

● Asset management: delete file assets

● Asset management: File-in-use indicator

● AutoFrames

● Auto Save

● Background sound support

● Column and Row options for HTML table structure 

● Custom names on buttons and banners

● Data publishing enhancements including support for BLOBs, image file paths, 
and automated creation of stacked pages with navigation (Windows only)

● Enhanced drag-and-drop Support

● Enhanced scripting 
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● Enhanced support for multiple assets for Java applets

● Enhanced visual support for ActiveX (Windows only)

● External HTML files supported visually

● Faster, optimized HTML table generation with HTML 3.2 validation

● Follow link navigation

● FTP port # selection 

● Generate Apple HotSauce MCF file

● Generate NetObjects SiteMapper file

● Generate Source Code Comments option

● GIF 89a Transparency support in Page view

● Horizontal and vertical navigation bars and banners

● HTML <HR> Lines (beveled dividers)

● Import sites and pages

● Insert Field Inside Text Element with support for Site variables, System variables, 
and User-Defined variables

● Insert HTML Syntax in text element

● Insert Layout templates

● Insert Page templates

● Layout size-to-fit

● Lock minimum size of text block

● MasterBorders

● Multiple Undo and Redo

● Navigation bar tool

● Navigation enhancements including support for custom styles for navigation 
bars
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● New text-over-pictures options

● Optimized HTML generation

● Paragraph styles

● Print Site structure view

● Publish changed assets only

● Publish enhancements

● Rotate pictures

● Rotate text over a button

● Save As…

● Show labels

● SiteStyles enhancements including 45+ new SiteStyles

● Size pictures

● Snap to guide

● Snap to grid

● Snap to object

● Spelling checker

● Text tool enhancements including Underline, Strikethrough, Subscript, and 
Superscript

● Verify and reset paths for files assets

● Verify and report on external links

● View HTML table structure in Page view

● Visual vertical and horizontal guides
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